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How Do | Know If My PDF Is Accessible?

The Session begins at 1:00 pm CST
We will be testing audio quality periodically

The content and materials of this training cannot be used or distributed without permission. This training is
funded under award #H133A060097 from the U.S. Department of Education through the auspices of the
National Institute on Disability and Rehabilitation Research (NIDRR. For permission to use training content or
obtain copies of materials used as part of this program please contact us by email at
adata@adagreatlakes.org o toll free (800) 949-4232 (V/TTY) in IL, IN, MI, MN, OH, and WI. For other all
other states call (312) 413-1407

Useful Keyboard Shortcuts

e Full list - Keyboard Shortcuts from the Help menu on
the Menu Bar.
¢ Speaker level Up:
Windows: Ctrl+Alt+Up Arrow
Mac: Command-Option-Up Arrow
¢ Speaker level Down:
Windows: Ctrl+Alt+Down Arrow

Mac: Command-Option-Down Arrow
¢ Chat: Move cursor to the Message text box

Windows: Ctrl+M

Mac: Command-M

More keyboard shortcuts

¢ Open Closed-Captioning window
Windows: Ctrl+F8
Mac: Command-F8

* Close Closed-Captioning window
Windows: Alt+F4 or Ctrl+W
Mac: Command-W
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Listening to the Webinar

¢ The audio for today’s webinar is being broadcast through
your computer. Please make sure your speakers are turned
on or your headphones are plugged in.

¢ You can control the audio broadcast via the Audio & Video
panel. You can adjust the sound by “sliding” the sound
bar left or right.

¢ If you are having sound quality problems check your audio
controls by going through the Audio Wizard which is
accessed by selecting the microphone icon on the Audio &

Video panel 4
[23auio & vipeo & .
) e . ) ——
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Listening to the Webinar, continued

If you do not have 1.712-432-3066
sound capabilities on

Pass Code:
your computer or 148937
prefer to listen by

This is not a Toll Free number
phone, dial:

Listening to the Webinar, continued

MOBILE Devices supported include iPhone, iPad,
Android Devices, Kindle Fire HD)**
Individuals can download the free Blackboard

Collaborate App from the Apple Store, Google Play or
Amazon

2

**Closed Captioning is not visible via the Mobile App and there is limited access to the white board for
individual's using voice over technology
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Captioning

* Real-time captioning is provided during this
webinar.

* The caption screen can be accessed by choosing
the iconinthe Audio & Video panel. '

* Once selected you will have the option to resize
the captioning window, change the font size and
save the transcript.

9/15/2015

Submitting Questions

¢ You may type and submit questions in the Chat Area Text Box or press Control-M
and enter text in the Chat Area

* If you are connected via a mobile device you
may submit questions in the chat area within
the App

* If you are listening by phone and not logged in to
the i you may ask i by ili
them to webinars@ada-audio.org

Please note: This webinar is being recorded and can be accessed on the website at www.ada-audio.org within 24
hours after the conclusion of the session.

Customize Your View

¢ Resize the Whiteboard where the Presentation
slides are shown to make it smaller or larger by
choosing from the drop down menu located
above and to the left of the whiteboard. The
default is “fit page”

5 ©®
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Customize Your View continued

* Resize/Reposition the Chat, Participant and
Audio & Video panels by “detaching” and
using your mouse to reposition or
“stretch/shrink”. Each panel may be detached
using the .= icon in the upper right corner of
each panel.

Setting Preferences

¢ Depending on your system settings you may receive visual
and audible notifications when individuals enter/leave the
webinar room or when other actions are taken by
participants. This can be distracting.
¢ To turn off notifications (audible/visual)
— Select “Edit” from the tool bar at the top of your screen
— From the drop down menu select “Preferences”
— Scroll down to “General”
« select “Audible Notifications” Uncheck anything you don’t want to
receive and “apply”

* Select “Visual Notifications” Uncheck anything you don’t want to
receive and “apply”
— For Screen Reader User — Set preferences through the setting
options within the Activity Window (Ctrl+slash opens the
activity window)

Technical Assistance

* If you experience any technical difficulties
during the webinar:

1. Submit a message regarding your issue via the
chat area and the Moderator will address your
concern via a private chat with you and/or refer it
to one of the Great Lakes ADA Center IT Staff to
contact you off line; or

2. Email webinars@ada-audio.org; or

3. Call 877-232-1990 (V/TTY)
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How Do | Know If
My PDF Is Accessible?

Christy Blew, M.S., C.C.T.
IT Accessibility Specialist

University of lllinois

9/15/2015

Obijectives

¢ Be familiar with accessible PDF terms (ie, tags)
and location of accessibility checking tools in
Acrobat XI

¢ How to activate and use the Form Editor to
add Tool Tips to form objects

¢ |dentify at least three items that are needed
to make a PDF accessible

May PDF be ever in your favor

When you hear
“Accessible PDF”

Great Lakes ADA Center
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Housekeeping

¢ Adobe is a company; they are the creators of
Acrobat

¢ Acrobat is a tool for creating, editing and
viewing PDF files, yet is not a word processing
program

e PDF is an export format type of document.
Just as you would get a piece of paper from a
printer, you get a PDF from Acrobat

PDF Structure

Visual Layer

(also referred to as the Physical Layer)

+  This is what you would associate as a “PDF
File”. It is the version that would exist if you
were to print out the PDF in a hard copy.

Content Layer
(also referred to as the Text Layer)
*  This layer contains the textual information

’
' - ’
accessible PDF, the reading order of the ' extor

Content Layer mimics the order implied by

the Visual Layout of the document. " V/SUa//a_VEf "

that is associated with the Visual Layer. In an

[

Tags Layer [
«  The Tags Layer contains the PDF tagging Pkl LT ]
structure (similar to HTML markup for a

xi:%%sé ;hat is used by assistive _.'. St Uelira/ ..'.
73gs

.....

PDF “Tags”

e “Tags” provide a structured, textual
representation of the PDF that is presented to
assistive technology (AT) such as screen
readers.

¢ AT can determine paragraphs, lists, tables,
form elements, etc. from tags.

* A PDF without tags appears either blank or as
one large block of text to AT.

Great Lakes ADA Center 6
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Where to find “Tags”

¢ Left side icon panel: the
tag icon

¢ View > Show/Hide >
Navigation Panes > Tags ? :

PDF/UA

I1SO standard for accessible PDF, sets clear rules
for developers and authors of tagged PDF
documents and forms.

* On February 18 2015 the US Access Board
announced its Proposed Rule for US federal policy
on accessibility, commonly known as Section 508.
The proposed rule identifies PDF/UA as
equivalent to WCAG 2.0 for “appropriate
content”

bty -board 1717-board-proposes-updated:ct-acce

PDF/UA Description

* A way to use Acrobat to produce documents available
to all persons, including those using AT

¢ Tags must correctly represent the document's semantic
structures (headings, lists, tables, etc)

¢ Problematic content is prohibited, including illogical
headings, the use of color/contrast to convey
information, inaccessible JavaScript, and more

¢ Meaningful graphics must include alternative text

¢ Security settings must allow assistive technology access
to the content

¢ Fonts must be embedded, and text mapped to Unicode

Great Lakes ADA Center 7
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Evaluation & Remediation

¢ Most people are trying
to find out if a PDF is
accessible or trying to
fix one they know is not
accessible

* Yes, this can be a
nightmare!

Why Evaluate?

¢ Sometimes no access to original document or
applications conversion does not maintain
tagging structure

e Currently there is no tool to automatically check a
PDF file for functional accessibility.

¢ There are tools currently that check some items,
but to check a PDF for full accessibility, you still
need to do manual checking.

“Quick Checks”

¢ Renderable Text — Text vs. Image

¢ Navigation Structure — PDF “Tags”

¢ Text Descriptions — Non Text Descriptions
¢ Table Structure

¢ Form Elements (including tab order)

¢ Reading Order

Great Lakes ADA Center 8
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NOTE!!!

* Some browsers will try
to “guess” what a PDF
has in it when there are
not tags. Some people
mistake this as being
“accessible” because
the browser finds text

¢ Most of the time AT will
still struggle with the
PDF

Accessibility Checker

e Built in Accessibility
Checker

¢ Detailed report on
accessibility

¢ Is a great 15t pass for
accessibility

* Easy to fix issues

¢ Notes manual checks

Using the Accessibility Checker

DOUBLE FACEPALM

&

MAILWITH _ ONLY.CONTAINS A
NOSUBIECT _INACCESSIBLE PDF

Great Lakes ADA Center 9



How Do | Know If My PDF Is Accessible? 9/15/2015

Working With Results

¢ Right click on an issue

to get more information
— Fix
— Skip Rule
— Explain
Just keep breathing....
o
“Complex PDF” Checks
Data Tables
¢ Use the Tags panel to check if cells are marked up with TD and TH
correctly
Charts

* Charts are considered non-text elements and should have
associated alt text

Forms
¢ Forms need to have Tool Tips and be a part of the Tag structure

Multimedia
¢ Audio should have a text transcript, Video should be captioned.

Great Lakes ADA Center 10
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Table Rules

* All tables must have at least one heading row

¢ Tables with a heading row and heading
column must use ID’s to identify cells

Table Editor

e Activate Touch Up
Reading Order Panel

* Table elements show :
with “X” through them |! e TSy

Clear page structure:

¢ Right click on table

¢ Select Table Editor

Identifying Cell Types

¢ Cells will highlight

¢ Color coded based on cell
type

¢ Select cell, right click, to
open properties

¢ Change cell type here

¢ Change colors in Table
Editor Options

Great Lakes ADA Center 11
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Change to Header Cell

¢ Select cells to change

¢ Select Table Cell
Properties

¢ Change to Header Cell

Assigning and ID to TH

e Each TH cell must have
an unique ID assigned
toit

¢ Enter this in the ID field
in the properties

¢ Use identifiable words
for ID

Associate TD with TH

¢ Assistive technology
uses the ID’s to
associate the TD cells

¢ In Properties, select the
“+” to show all available
IDs

e Select the ID’s that
correspond to that cell

Great Lakes ADA Center 12
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Check Table in Tags

¢ Double Check Table in
Tags Panel

B oston Marathon Woesen's WCR el

e THvsTD

e Correct # of cells

e Complex Table Check

Complex Tables

Merged cells Does not seem to match up

S = T [ e | e

.....

Fixing Complex Tables

Retagging gets close Compare to Tags to clean up

Great Lakes ADA Center 13
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Don’t Get Discouraged by Tables

¢ Yes, it may take extra time
to figure out

¢ Yes, you may have to do it
more than once

* Yes, you may use
inappropriate language

AND....
YOU CAN DO IT!

e Tools > Forms > Edit
¢ Auto-detect based on form

Form Elements

¢ Text Fields — Fill in the blank

¢ Check Boxes — Select one or more options

* Radio Boxes — Select only one from multiple
options

Great Lakes ADA Center 14
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Form Editing Mode

9/15/2015

e Add Fields
« Edit Fields o |8 ceremii |
~ Tasks
¢ Close Editor WG A New ik
& ¢
EchoSign
gﬂw"mrnchh m
Fields
SortBy = b Ord
] Page1

Add a Field

SAMPLE QUERY

Hame;

Addre:

Role {chf

SAMPLE QUERY
Nas

Epuc,

Degree:

e Add New Field

* Place Field

¢ Enter (visually will change)
e Select ALL PROPERTIES

Tooltips

e Assistive Technology
identifies form fields via [
tooltip

¢ Make sure tooltip notes
what needs to be
completed

* Sometimes may need to
put a full question in a

tooltip

Great Lakes ADA Center
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Checking Tooltips

e Check in the properties

box in the Form Editing [[] associates
Mode B e
¢ Hover mouse over form [ wasters
element in reading
mode
Form Order

3 3
SAMPLE QUERY

=
Role (choose anly one) @Studenl f

EDUCATION
Degrees Earned {check all that apalyk=
E Associates== "
B sachetors ==~
- -
E masters=” o7

= -
Doctorate”

Change Form Tab Order

¢ Dragand Drop

¢ Match order to logical
reading order of
document

Great Lakes ADA Center 16
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Add/Edit Form Elements

9/15/2015

You Survived!

PDF/UA Resources

* PDF/UA — Wikipedia:
http://en.wikipedia.org/wiki/PDF/UA

* PDF/UA in a Nutshell:
http://www.pdfa.org/publication/pdfua-in-a-nutshell/

¢ Making a simple document accessible in

Acrobat Pro XI: http://itaccessibility.illinois.edu/pdf/docaccessXI

Great Lakes ADA Center
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Accessible PDF Tutorials

¢ WebAIM - ttp://webaim.org/techniques/acrobat/

L4 Lynda.com - http://www.lynda.com/Acrobat-tutorials/Creating-
Accessible-PDFs-2014/147579-2.html

e Cal State - http://www.calstate.edu/accessibility/tutorials/pdf.shtml

9/15/2015

¢ Google: “PDF Accessibility Tutorials”

About Christy

Christy Blew is an IT Accessibility Specalist in the Division of
Disability Resources and Educational Services (DRES) at the
University of llinois at Urbana-Champaign. She has over 15 years of
experience in developing and using internet technologies to deliver
information to people and has been working with IT accessibility
education for over 10 years. Christy is part of the [Taccess intiative
atthe University of llinois that focuses on the awareness,
evaluation, and education of accessibility of electronic information.
Her online and classroom training sessions include accessibility
issues with Word, PowerPoint, and PDF. She is a member of the
WC Protocols and Formats working group and the International
Association of Accessibility Professionals (IAAP). Christy currently
holds a Masters in Technology and a Certification in Computer
Science from Eastern llinois University, and a certificate in Audio
Description through Audio Description Associates, LLC.

Christy can be reached at clblew@illinois.edu.

BINARNSERIES

Thank you for participating!

NEXT SESSION IS NOVEMBER 19, 2015

Social Media, Accessibility,
and Disability Inclusion

The session today was recorded
and will be archived at
HTTP://ADA-AUDIO.ORG/ARCHIVES/ACCESSIBLETECH/

Great Lakes ADA Center
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